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Introduction 

 

Introduction 
 

This section provides valuable information about teaching TechnoEarth. It 

includes a description of the Teacher Guide, as well as an overview of the 

course. In addition, there are ideas for implementation and technology 

integration.  

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 

 

How to Use this Guide 

Course Overview 

Implementation and Technology Integration Ideas 
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How to Use This Guide 

This Teacher Guide contains the following: 

Getting Started – This section contains a course description, as well as ideas for implementation. 

Course Instructions – The course is comprised of six sessions, each focused on a problem-solving 

task that aligns with the project theme. Each session includes assignments that break down the 

task into manageable steps. The components of each session are as follows: 

➢ Overview – An explanation of the session activities and their purpose.

➢ Materials – A list of handouts, sample files, templates, and teacher resource materials

needed to teach the session.

➢ Teaching Strategies – Instructional methods recommended for teaching the activities.

➢ Lesson Plan – A detailed list of each step in the session.

➢ Learning Objectives – A summary of the content knowledge and technical skills taught

throughout the session.

➢ Assignments – A session consists of assignments completed by students. Actions to be

performed on the computer by the student are indicated with a triangle (). Background

information is indicated with a dash (–).

➢ Review – A session review contains a list of fill-in-the-blank, multiple choice, or short-answer

questions intended to review terminology and tools. (answers included).

➢ Skill Review – An additional assignment intended to review Internet search or design skills

(includes completed sample).

➢ Extension Activity – An additional activity that relates to the problem-solving task

presented in the session.

Appendices – this section contains additional information or materials including the following 

resources. 

➢ Assessment Tools – Skill summary and marking sheet to evaluate the infographic.

➢ ISTE Correlation – A summary of learning outcomes.

➢ Glossary – A definition of each term.

➢ Contact Information – How to contact TechnoKids Inc. for curriculum support.
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TechnoEarth Overview 

Introduction to TechnoEarth 

 

In this course, students become environmental stewards. They design an 

interactive infographic that informs the public about an important issue. The 

web-based publication will outline the cause, harmful effects, and solutions. It 

will also include a rotating slide deck that summarizes the stakeholders and 

highlights interesting facts. To engage viewers, a thematic map will pinpoint 

where the problem is happening. Upon completion, students will inspire others 

to get involved by sharing their findings at an Earth Keeper's Conference. 

 

Students complete the following tasks: 

 

➢ In Session 1, students become environmental stewards. They prepare to create an 

infographic that informs the public about an important issue. To start, they study 

example publications to gain an understanding of the content and design 

elements. Next, they research a topic including cause, effects, interesting facts, 

location, stakeholders, and solutions. A reference list tracks sources of information. 

By the end of the session, students complete a checklist to verify they are ready 

to design their infographic. 

➢ In Session 2, students begin to build their infographic using Google Sites. They 

introduce an environmental issue, describe the cause, and illustrate harmful 

effects. An emphasis is placed upon conveying information concisely using 

catchy headings and simple clip art. Instructions direct students to chunk their 

data into sections using color and dividers. 

➢ In Session 3, students create a rotating slide deck using Google Slides. It will 

emphasize interesting facts and outline stakeholders. To start, students use a big 

number to highlight the scale of the problem. Next, they point out an important 

detail using colorful word art. Afterwards, they construct a diagram that 

summarizes who has a stake. Upon completion, the slide deck is inserted into the 

infographic and set to automatically play. Instantly the viewer should be able to 

grasp the scope of the environmental issue. 

➢ In Session 4, students produce a thematic map using Google My Maps. It will 

pinpoint locations where the environmental issue is happening. The places could 

be worst offenders, best stewards, disaster sites, at-risk regions, successful 

conservation projects, or legally protected areas. Each marker will display an 

interesting fact and a photo. The map will be inserted into the infographic 

allowing viewers to explore and learn about the topic. 

➢ In Session 5, students illustrate solutions to the environmental issues by designing 

their own icons using Google Drawings. Each image will be a simple 

representation made by combining shapes, word art, and cropped images. The 

original artwork will be inserted into the infographic with an explanation. A link to 

an advocacy group will invite viewers to get involved. 

➢ In Session 6, students raise awareness about an environmental issue. They publish 

their infographic using Google Sites. Afterwards, they share their infographic at an 

Earth Keeper’s Conference. 
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Technology Integration Ideas 

TechnoEarth is a cross-curricular unit that integrates Google applications into curriculum. In this 

course, learners become environmental stewards. They create an infographic about an 

important issue. The publication is shared with others to raise awareness. The activities blend 

technology into geography, science, language arts, and visual arts. Lessons are ideal for middle 

and high school students. Below are some suggestions for implementing TechnoEarth: 

• Information, Communication, and Technology Skills: Teach TechnoEarth as part of a

technology course. The activities in TechnoEarth combine multiple Google applications

to produce the infographic. This allows students to transfer their skills from one learning

task to the next. It also demonstrates the practical use of each application and shows

how they can be combined to produce a final product. Refer to their use:

o Google Docs organizes environmental research

o Google Sites produces the infographic by summarizing information in sections

o Google Slides creates a rotating slide deck of interesting facts and stakeholders

o Google Sheets charts data using a scorecard

o Google My Maps pinpoints important locations on a customized map

o Google Drawings illustrates a concept with the creation of an original icon

• Geography: Include TechnoEarth as part of a geography class. By creating an

infographic about an environmental topic, students explore the connection been

human activity and the natural environment. They summarize information about the

cause, harmful effects, stakeholders, location, and solutions. This investigation fosters an

understanding of the importance of stewardship and sustainability.

• Science: Use the lessons in TechnoEarth as part of an environmental unit. It could be

integrated into many areas of study including biodiversity, energy, ecosystems, pollution,

conservation, or water systems. The infographic demonstrates learning in a meaningful

way.

• Language Arts: An emphasis in TechnoEarth is on research and communication skills.

Support is given to boost students’ search strategies, paraphrasing techniques, and

ability to organize data. Interwoven through the activities are hints to convey a simplified

message by combining text and images effectively.

• Visual Arts: Target visual arts learning outcomes with TechnoEarth. Graphic design is an

important element of the lessons. Students apply their creativity to organize information

and arrange content. Moreover, they use digital paint tools to produce original artwork.

Understand the Big Picture 

Not sure where to integrate TechnoEarth? There are three samples provided for this course 

including infographics about acid rain, coral bleaching, and the seal hunt. These web-based 

publications provide ideas on how you can include these activities in your curriculum. 



 

 

 

Session 1 Become an Earth Keeper 

 

Session 1 
Become an Earth Keeper 

In this session, students become environmental stewards. They prepare to 

create an infographic that informs the public about an important issue. To 

start, they study example publications to gain an understanding of the 

content and design elements. Next, they research a topic including cause, 

effects, interesting facts, location, stakeholders, and solutions. A reference list 

tracks sources of information. By the end of the session, students complete a 

checklist to verify they are ready to begin to design their infographic. 

 

Assignment 1: What Is Environmental Stewardship? 

Assignment 2: What Is an Infographic? 

Assignment 3: Pick an Environmental Topic 

Assignment 4: Research the Issue 

Assignment 5: Pinpoint the Location 

 

Session 1 Skill Review 1: Boost Search Strategies 

Session 1 Skill Review 2: Reference Sources of Information 

Session 1 Extension Activity 1: Recognize Bias 

Session 1 Extension Activity 2: Assess Trustworthiness of a Site 

 



Session 1 

Copyright © TechnoKids Inc. 2 TechnoEarth | Google Workspace 

Session 1 Getting Started 

Overview 

In this session, students become environmental stewards. They prepare to create an infographic 

that informs the public about an important issue. To start, they study example publications to 

gain an understanding of the content and design elements. Next, they research a topic 

including cause, effects, interesting facts, location, stakeholders, and solutions. A reference list 

tracks sources of information. By the end of the session, students complete a checklist to verify 

they are ready to design their infographic. 

Materials 

• Chrome web browser

• Assignments 1 – 5

• Research Outline template

• Research Checklist

• Example infographics

• Environmental Fact Sheets:
acid rain, clear cutting, endangered reefs, fuel emissions, garbage, invasive species, mountaintop mining,

nuclear energy, oil sands, overfishing, plastic pollution, poaching, water consumption

• Session 1 Skill Review A: Boost Search Strategies

• Session 1 Skill Review B: Reference Sources of Information

• Session 1 Extension Activity A: Recognize Bias

• Session 1 Extension Activity B: Assess Trustworthiness of a Site

Teacher Preparation 
(Refer to the Prepare to Teach section of this course for instructions) 

• Make the files in the Earth folder available to students. It has links to example

infographics, as well as the Research Outline template.

• Determine the competence level of students to conduct Internet research efficiently.

Refer to the skill reviews and extension activities at the end of this Session. These optional

activities can be used to strengthen Internet search skills.

• Review the fact sheets. They are one-page documents that summarize information on a

range of environmental topics. These can be used to support learning.

Teaching Strategy 

In this course, students design an interactive infographic that raises awareness about an 

environmental issue. Explain the TechnoEarth scenario: 

In this course, you raise awareness about an environmental issue by 

designing an interactive infographic. An infographic is a one-page 

document that uses simple imagery and text to convey information. Your 

publication will outline the cause, harmful effects, and solutions. It will also 

include a rotating slide deck that summarizes the stakeholders and 

highlights interesting facts. To engage viewers, a thematic map will 

pinpoint where the problem is occurring. Upon completion, you will inspire 

others to get involved by sharing your findings at an Earth Keeper's Conference. 
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In this session, students conduct research on an environmental topic. Explain session scenario: 

 

In this session, you become an environmental steward. This is someone that takes care of 

the Earth and inspires others to act. To begin, you read about current events to discover 

issues of personal interest. Next, you study example infographics to notice the unique way 

simple images and text convey information. Afterwards, a brainstorming activity helps you 

to select a topic. You then conduct research and organize the findings using a template. 

By the end of this session, you should be ready to construct your infographic. 

 

 

Assignment 1: What Is Environmental Stewardship? 

 

In this assignment, students become environmental stewards. They read about the importance 

of a healthy environment and stewardship. To gain an understanding of current events, they 

read Google News headlines. The goal is to familiarize students with local, national, and 

international environmental concerns.  

 

This activity can be completed independently or as a whole group. Instruct students to consider 

areas of interest as they read the headlines. This will help them in Assignment 3 to brainstorm an 

environmental issue for their infographic. You may wish to make a class list of headlines to 

broaden students' knowledge of problems, conservation efforts, and use of natural resources.  

 

Introduce the following terminology: 

• stewardship: responsibility for something of importance 

• sustainable: able to continue for a long period of time with no decline 

 

Assignment 2: What Is an Infographic? 

 

In this assignment, students study an infographic to gain an understanding of how it can be used 

to communicate information effectively. They answer questions about the content and layout. 

Additional publications are available in the Samples folder. 

 

Introduce the following terminology. 

• infographic: one-page publication that summarizes a topic in a graphic way using simple 

icons, symbols, maps, and charts to explain the data.  

 

 

 

The infographic is designed using Sites.  

HEADER: Introduce the topic. Include a solid 

color or simple image as the background. 
(Session 2 – Assignment 6) 

CAUSE: Describe the issue and explain why it 

is happening. Adjust the text style and 

format the section. (Session 2 – Assignment 7) 

EFFECTS: Identify two harmful effects using 

Layouts. Represent the problem with clip art. 
(Session 2 – Assignment 8-9) 

INTERESTING FACTS & STAKEHOLDERS:  

Create a rotating slide deck in Slides. Use 

numbers, Word art, shapes, and symbols to 

emphasize data. (Session 3 – Assignments 10-13) 

LOCATION: Pinpoint places related to the 

issue using Maps. Customize the marker. 
(Session 4 – Assignments 14-15) 

SOLUTIONS: Design icons to represent solutions 

using Drawings. (Session 5 – Assignments 16-17) 

SOURCES: Cite sources of information using a 

collapsible text box. (Session 5 Extension Activity) 

IMAGE CAROUSEL & SCORECARD: Display  

photos or highlight an important value using 

Sheets. (Session 2 and 4 Extension Activities) 
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Assignment 3: Pick an Environmental Topic 

In this assignment, students brainstorm a topic for their infographic. They complete a mind map 

that includes categories of environmental issues. You may wish to complete the activity as a 

whole group to produce a master list. Use the suggestions below if students are stuck for ideas. 

Suggestions for selecting a topic: 

✓ Pick a topic of personal interest

✓ Look for a local, national, or international area of concern

✓ Make a connection with topics being studied in other subject areas

✓ Narrow a broad topic to focus on a specific issue

✓ Expand brainstorming beyond the mind map environmental categories

Topic ideas: 

Environmental Issues 

carbon emissions fossil fuels overfishing water pollution 

greenhouse gases nuclear energy shark finning water consumption 

melting polar ice caps coal power bottom trawling water bulk removal 

ozone depletion hydroelectric power bycatch ocean deoxygenation 

melting glaciers natural gas ghost nets ocean acidification 

rising sea levels radiation spills whaling watershed 

air pollution fuel emissions seal hunt algae blooms 

smog renewable energy endangered reefs agricultural pollution 

acid rain oil sands coral bleaching overgrazing 

urban sprawl oil drilling biodiversity loss irrigation 

garbage oil spills habitat destruction slash and burn 

disposal of waste strip mining cave conservation pesticide drift 

toxic waste mountaintop mining desert conservation soil contamination 

landfills subsurface mining poaching soil degradation 

industrial waste acid mine drainage endangered species deforestation 

littering light pollution wildlife trade logging 

plastic pollution invasive species predator loss clear cutting 

water bottles common carp light pollution natural disasters 

shopping bags kudzu invasion noise pollution wildfires 

words in bold have a fact card 

Do your students need to improve their…? If yes, then do this activity: 

efficiency of online search skills Skill Review: Boost Search Strategies 

ability to find information for citing the source Skill Review: Reference Sources of Information 

understanding of bias and how it slants data Extension Activity Recognize Bias 

judgment used to verify if an article is reliable Extension Activity Assess Trustworthiness of a Site 

Strengthen Internet Search Skills Prior to Assignment 4: 

Environmental topics are complicated issues. Each stakeholder will have a 

website outlining their viewpoint.  Your students need to be able 

to find high quality information quickly, cite the source, recognize bias, and 

determine trustworthiness. Refer to the skill reviews and extension activities at the 

end of this Session. These can be assigned to the class or individual students. 
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Assignment 4: Research the Issue 

 

In this assignment, students research their environmental issue. They collect facts about the 

cause, effects, interesting facts, stakeholders, and solutions. The information is categorized using 

a Google Docs template.  Note that all the sections of the outline are to be completed, except 

Location, which is done in the next assignment. 
 

Introduce the following terminology: 

• stakeholder: person, business, group, or organization who have an interest in the issue 

• source: website from which the data was found 

 

Research Tips: 

• Use Expert Sites: Many people have opinions about environmental issues. However, when 

gathering facts, it is important to use websites from experts such as government websites, 

educational institutions, environmental organizations, associations, and encyclopedias.  

• Be Selective: An infographic has limited text and relies primarily on images to convey 

information. Caution students to copy and paste only brief excerpts from Internet sites. 

This will make it easier to condense and rephrase the data later. 

• Bookmark Websites: You may want to teach students how to bookmark informative 

websites. That way they can return to them later if they need more facts. 

• Record Only the Web Address: If your class has limited time for research, you may wish to 

restrict citing of the source to only the website address. 

• Cite the Source: If you have specific formatting requirements for references, for example 

APA or MLA format, let students know before beginning. Provide a sample. 

• Refer to Fact Sheets: Environmental topics are complicated issues. Internet sites tend to 

be written with an elevated level of scientific detail and complex vocabulary. Use the 

Fact Sheets for simpler summary outlines to address individual student needs.  

 

Assignment 5: Pinpoint the Location 

 

In this assignment, students highlight the scope of the environmental issue. They identify where it 

is happening in the world. This data is used to create an interactive map in Session 4.  
 

Location Tips: 

• Demonstrate an Interactive Map: Show students the sampler, Acid Rain. Draw attention 

to the content of each marker, including a description and photo. 

• Discuss the Range of Possibilities: Each environmental issue is unique. The locations can 

be the worst offenders or best stewards. It could pinpoint a disaster site, at-risk region, 

main contributor, organization, successful environmental project, or stakeholder. 

• Find a Specific Place: A country name is often too broad. To be able to accurately pin 

the map marker students should identify the state, city, or region. 

• Type of Interesting Fact: For two of the places, students must provide an interesting fact. 

It can be numerical, stating the size of the problem, or factual, explaining the cause, 

harmful effects, or solution efforts that are being made.  

 

Research Checklist 

 

Encourage your students to verify they are prepared to build their infographic. The checklist is 

available as a digital file in the Assessment folder if you would like to customize the criteria.  

https://sites.google.com/view/aboutacidrain/home
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Lesson Plan 

Assignment 1: What Is Environmental Stewardship? 

• Consider reasons why people should care about the environment.

• Read about the role of an environmental steward.

• Browse current events about environmental topics.

• List three headlines with environmental concerns that are of personal interest.

Assignment 2: What Is an Infographic? 

• Read about infographics and study a picture that summarizes its main features.

• Find out why infographics are used to communicate.

• Explore an infographic. Answer questions to examine the content and design features.

Assignment 3: Pick an Environmental Topic 

• Brainstorm environmental topics related to air pollution, water pollution, overfishing,

waste, invasive species, endangered species, energy, agriculture, forestry, and mining.

• Decide on the topic for the infographic.

Assignment 4: Research the Issue 

• Open the Research Outline template in Google Docs.

• Navigate from one heading to another in Document Outline View.

• Apply Internet search skills to research the cause of the problem.

• Find a fact and copy it from a web page.

• Paste the fact into the template without formatting.

• Record the URL to cite the source of information.

• Complete the research by categorizing the facts under appropriate headings.

Assignment 5: Pinpoint the Location 

• Open the Research Outline.

• Go to the Location section using Document Outline View.

• Apply skills to research interesting facts about at least two locations.

• Organize location data and interesting facts using a table in the Research Outline.

• Record the URL to cite the source of information.

Research Checklist 

• Complete the research checklist.



Session 1 

Copyright © TechnoKids Inc. 7 TechnoEarth | Google Workspace 

Learning Objectives 

 

Content Knowledge 

• define the terms stewardship, sustainable, and stakeholder 

• browse news articles about environmental topics 

• explore the connection between human activity and the natural environment 

• identify the characteristics and purposes of an infographic 

Research Skills 

• brainstorm topics for an infographic using a mind map 

• narrow broad topics to specific issues 

• investigate an environmental issue 

• categorize information using a research organizer 

• summarize, condense, and rephrase researched information   

• reference sources of information 

 

Internet Skills/Digital Citizenship 

• toggle between tabs in a browser 

• apply search strategies to find resources related to a specific topic 

• copy a selection from a web page 

• curate a collection of websites 

• refine search strategies using a variety of techniques (optional) 

• cite the author, date, title, and website address of sources (optional) 

• scrutinize information on the Internet to determine bias (optional) 

• assess the reliability of online information (optional) 

 

Word Processing Skills 

• organize information in a document using heading styles 

• navigate through a document in Document Outline View 

• paste a copied selection with no formatting 

 

Applied Technology 

• research facts about an environmental issue including cause, effects, interesting facts, 

stakeholders, location, and solutions 
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Assignment 2: What Is an Infographic? 

You are going to make an infographic that raises awareness about an environmental issue. 

Read to learn about this type of publication. Afterwards, view a sample to get ideas.  

 

What Is an Infographic? 

 

An infographic is a big picture that summarizes a topic. It is a one-page publication that 

presents information in a graphic way. Simple icons, symbols, maps, and charts combine to 

explain the data. Text is only used as labels or to briefly describe facts. The viewer explores the 

content by studying each section of cartoon-like images. 

 

 
 

 

 

Why Use an Infographic? 

 

An infographic is a simple but powerful way to communicate. There are many reasons to use it: 

• catches the interest of the viewer 

• outlines many facts in a compact space 

• conveys data quickly using images 

• informs without lots of written information 

• engages the viewer to think about the topic because they must explore each part 

• makes a complex issue easy to understand  

Your infographic will 

be interactive. The 

viewer will experience 

the information rather 

than just read it. 
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Characteristics of an Infographic 

 Visit https://sites.google.com/view/aboutacidrain/home

If the above link does not work, open the Infographic Samples document in Student Resources. 

CONTENT 

1. How does human activity cause the problem?

2. What is a harmful effect or risk related to the issue?

3. Watch the rotating slide deck. List an interesting fact.

4. Click a map marker. List one place where the problem occurs.

5. Find a solution to the problem. What is it?

DESIGN 

6. Text is used for headings and to report brief facts. Which heading catches your attention?

7. Simple images explain the data. What kind of images were used?

symbols, clip art, drawn images, maps, pictograph

8. Numbers emphasize important facts. What number catches your attention?

9. Color should suit the topic. Why did the creator use the color theme?

10. Information is chunked into parts. How is the topic divided into sections?

blocks of color, divider line, bold headings

https://sites.google.com/view/aboutacidrain/home
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Research Checklist 

As an environmental steward your job is to inform people about an important issue. 

Use the checklist to make sure you have the facts to create your infographic. 

If you are missing something, complete your research. 

My research… ✓

Cause 

describes the issue and connects human activity to the problem 

Effect 

lists two harmful effects or risks 

Interesting Facts 

outlines three facts that people will want to know 

 has a fact that contains a value such as a price, amount, or percentage 

Stakeholders 

identifies three businesses, organizations, or groups of people with a "stake" 

provides an explanation of how each stakeholder is involved 

Location 

pinpoints at least two places related to the issue 

includes an interesting fact about two of the places 

Solutions 

highlights at least two solutions 

identifies a reputable organization or group and describes their activities 

Sources 

cites the website address for each site where information was found 
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Session 2 
Warn Others of the Issue 

In this session, students begin to build their infographic using Google Sites. They 

introduce the environmental issue, describe the cause, and illustrate harmful 

effects. An emphasis is placed upon conveying information concisely using 

catchy headings and simple clip art. Instructions direct students to chunk their 

data into sections using color and dividers.  

Assignment 6: Start to Design an Infographic 

Assignment 7: What Is the Cause? 

Assignment 8: What Are the Harmful Effects or Risks? 

Assignment 9: Preview the Infographic 

Session 2 Review: Practice Paraphrasing Strategies 

Session 2 Skill Review: Communicate with Images 

Session 2 Extension Activity: Photo Gallery of Harmful Effects 
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Assignment 8: What Are the Harmful Effects or Risks? 

In this assignment, you explain the harmful effects of the environmental issue. A simple clip art will 

be used to represent each risk. The viewer should be able to understand the problem by looking 

at the image and reading the heading. 

Example of Effects section.  

Simple images represent each harmful effect. 

Use a Layout to Illustrate Harmful Effects 

1. Open the infographic in Google Sites.

2. Click Insert. Under Content Blocks, pick a layout. It should include blocks of text.

Represent a Harmful Effect with an Image 

3.  Click the image box.  Pick Select image. 

 Click Google Images.

 Type effect clipart into the search box. Press ENTER.

 Pick an image you like. Click Insert.

If you do not like the picture, click Undo last action  . Pick another one. 

Pick the layout that fits the 

number of harmful effects. 

If you cannot find a 

symbol, try these ideas: 

• hazard

• danger

• stop

• exclamation

• cancel

• sad face

• delete

• end

• caution

• warning

• poison

Images should be: 

• clip art, not a photo

• symbolic of the problem

• simple

• easy to see when small

• rectangle shape

You may have to click the Content 

Blocks arrow  to open the layouts. 
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Crop the Image (Optional) 

 

4.  Resize the image in the frame. 

 

  If the picture is too big, click Crop.  

  ○ Drag the slider.  

  ○ Reposition the image inside the frame.  

  ○ Click the check mark.  

  If the picture cannot be cropped to your liking, try removing the cropping: 

  ○ Click Uncrop.  

 

Explain the Harmful Effect 
 

5.  Click inside the corresponding text box. Type the Harmful Effect Name. 
  

  Click inside the second text box. Type a brief description of the damage or risk. 
 

 
 

 

Add the Remaining Harmful Effects Then Insert a Divider to Separate the Section 
 

6. Apply your skills to complete the harmful effects. 
  

7. Click Insert. Pick Divider. 
  

 A line will show at the bottom of the last section: 
 

 
 

 
 

Sign Out

DESIGN TIPS 

• Add a divider line both above and below the section. 

• If your images are not transparent, you should keep the background white. 

• To swap an image, click it two times slowly. Click . Pick Replace image, then Select. 

• Adjust the size of the picture by clicking the picture and dragging the sizing handles. 

You can move  

the divider above 

the section.  
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Session 2 Skill Review: Communicate with Images 

An infographic uses images such as clip art, icons, or symbols to tell the viewer about a topic. 

Follow the instructions to design a publication about the harmful effects of clear cutting.  
 

1. Create a new Google Sites document.  
  

2. Type images into document name box.  
  

 3. Type Clear Cutting in the Your page title box. 
  

4. Click Themes. Select Aristotle. Pick a brown or green color to suit the topic. 

  
  

5. An infographic uses simple clip art, not photos. Find a plain image for the banner: 

 a. Hover over the banner. Click Image.  From the list pick Select. 

  

 b. Select Google Images. Type forest clipart in the search box. Click Search.  

 c. Pick a forest image you like. For example: 
  

  
  

6. Add information about the cause: 

 a. From the Insert pane, select the first content block layout. 

  

 b. In the first text box type the title No Tree Left Standing! 

 c. In the second text box type in the description:  

Clear cutting removes all the trees from an area to save logging companies money. 
  

7. When looking for images think of words that have a similar meaning.  

Illustrate the cause of clear cutting, which is logging: 

 a. Click the image box.  Pick Select image.  Click Google Images. 

 b. Search for clip art. Try clear cutting and logging as keywords. Which is better? 

 c. Pick an image that shows the cause of the problem. For example: 
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8. You will illustrate three harmful effects. From the Insert pane, select the fourth layout.

9. An image can be an object that relates to the fact.

Find an animal to illustrate the harmful effect loss of habitat:

a. In the first text box type in the title Loss of Habitat.

b. In the second text box type:

Clear cutting destroys the homes of many woodland animals.

c. To illustrate the problem, find a clip art of a moose, elk, or deer.

10. An image can be a symbol or sign.

Find a sign to illustrate the harmful effect landslides:

a. In the first text box type in the title Landslides.

b. In the second text box type:

Clear cutting can cause landslides which removes topsoil.

c. To show this risk, use the search term landslide sign.

11. Google will make suggestions when you enter keywords.

Use this tip to illustrate the harmful effect of slow regrowth.

a. In the first text box type in the title Slow Regrowth.

b. In the second text box type:

Replanting trees often does not work as the seedlings die.

c. Search for a clip art using the search term forest.

d. View the other suggestions. This is called predictive text.

e. Use a suggested keyword to find a suitable clip art.

12. Apply a color to the section background.

a. Hover at the left side of the text box. Click Section colors.

b. Pick an option from the list:

13. Sign out.

DESIGN TIPS 

• To make the descriptions easier to read, select the text. Click the Styles arrow. Pick Heading.

• If your images are not transparent, you should keep the background white.

• To swap an image, click it two times slowly. Click . Pick Replace image, then Select

• .



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



Session 3 Highlight the Facts 

Session 3 
Highlight the Facts 

In this session, students create a rotating slide deck using Google Slides. It will 

emphasize interesting facts and outline stakeholders. To start, students use a 

big number to highlight the scale of the problem. Next, they point out an 

important detail using colorful word art. Afterwards, they construct a diagram 

that summarizes who has a stake. Upon completion, the slide deck is inserted 

into the infographic and set to automatically play. Instantly the viewer should 

be able to grasp the scope of the environmental issue. 

Assignment 10: How Big Is the Problem? 

Assignment 11: Hook the Viewer's Attention 

Assignment 12: Who Are the Stakeholders? 

Assignment 13: Create a Rotating Slide Deck 

Session 3 Review: Slides Formatting Tools Quiz 

Session 3 Extension Activity: Inform with a Pictograph 
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Assignment 12: Who Are the Stakeholders? 

In this assignment, you add a diagram to the rotating slide deck. It will identify the stakeholders 

who have an interest in the issue. An organizer with text boxes will divide the information. 

Example of Stakeholder slide.  

To get ideas watch the stakeholder presentation. 

Who are three stakeholders? 

Insert a New Slide and Apply the Blank Layout 

1.  Open the FACTS slide deck in Google Slides.

 Select the last slide in the pane. Press the ENTER key to insert a new slide.

 Click Layout.  Select Blank. 

Choose a Diagram 

2.  From the Insert menu, select Diagram.

 Choose Process, Relationship, or Cycle. Look at the options.

 Change the Steps to the number of stakeholders. Pick a Color.

 Click on the diagram to place it on the slide. If you do not like it, click Undo.

The diagram should: 

• identify the stakeholder

• explain each "stake" in

only a few words

• match the infographic's

color scheme

• be easy to understand

quickly

Try different colors and diagram 

options until you find the perfect one! 

• Pick a design that has two text

boxes for stakeholder name and

interest.

• Unwanted text boxes or extra

shapes can be deleted.

• Click  Back to view a different

category.
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Resize the Diagram to Fill the Slide 

 

3.  Click and drag around the diagram on the slide to select it. 
 

 
 

  Drag the sizing handles to resize the diagram. 
 

 
 

 

Add Information to the Diagram 

 

4.  In each main text box type the Name of the Stakeholder. 

  

  In the joining text box describe the stakeholder's interest. How are they involved? 

 

 
 

  Format the font size.   IT CANNOT BE LESS THAN 24 points. 

  

  If the text does not fit, resize the text box. For example: 
 

 
 

  Delete any unwanted text boxes. 

 

 

Improve the Design of the Diagram 

 

5.  Use your skills to make the diagram look great: 

 

o Fill the shape with color.  It should suit the topic and match the infographic. 

o Apply a different font  or size  to the stakeholder name. 

o Format text color.  You may have to click More  to find other tools on the toolbar. 

 

 
  

If there is no second text box, try these ideas: 

• press ENTER to type on the next line 

• draw a text box  

 

The shapes might be 

grouped. You may need 

to click on a text box 

twice to select it. 

Use Paint format  to 

copy formatting from 

word to another. 
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Insert Icons to Represent Each Stakeholder (Optional) 

6.  Click Insert image.

 Click Search the web.

 In the search pane, type stakeholder or an object that shows what they gain.

 Pick one you like. Click Insert.

 Use your skills to resize  and place  the image. 

Complete the Diagram 

7. Apply your skills to make the slide look great!

Sign Out 

DESIGN IDEAS 

• Change the slide background color.

• Resize  and move  the text boxes to fit the information. 

• To swap an image, select Replace image. From the menu, click Search the web.

• To recolor an image, select Format options. Pick Recolor. Select an option from the gallery.

• To create more space, move a stakeholder group. Now select all stakeholder groups.

From the Arrange menu select Distribute. Pick Vertically  or Horizontally.

SELECTION TIPS 

• Press the TAB key on the keyboard.

• If you cannot grab an object, from the Arrange menu, select Ungroup.

Search suggestions: 

• clip art

• icon

• symbol

The diagram should 

instantly inform viewers 

about the stakeholders. 
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Session 3 Extension Activity: Inform with a Pictograph 

An infographic often uses a pictograph to communicate information. A pictograph is a graph 

that is made from pictures. Each image represents a value. It could be a fraction, ratio, percent, 

price, or other unit of measure. Create a slide that includes a pictograph. 

 

 

 

  

key: = 10 million people 

depict the amount of things 

copy and paste to show a group 

 
key: = one fifth 

represent a fraction or ratio 

recolor an image to show a value 

key: = 10% 

illustrate a percentage 

crop an image to show a portion 
 

 

Fact:  
 

 

Key:  =  

 symbol  unit of measure 

 

 

1. Open the slide deck in Google Slides. 

  

2. Select the last slide thumbnail. 

  

3. Click the New slide arrow.   Select Main point or Big number. 

 
 

4. Use your skills to describe the fact. Format the font  , size  , and style.  

  

5. Insert an image to represent the value. 

 a. Click Insert image.  

 

 b. Click Search the web.  Type a search word. 

 c. Click on an icon you like. Click Insert. 

 d. Resize   and move  the icon . 

  

6. Duplicate images to create a group: 

 a. Select the icon. 

 b. Press CTRL+D or choose Duplicate  from the Edit menu.  

 d. Repeat to add multiple images that represent the number. 
 

 

  

To find simple images, 

add clip art, symbol, or 

icon to the search term. 

To quickly make a group, select several icons. From the Arrange menu, select Group.  

Copy  and paste  the grouped icons. 
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6. Align and distribute a row of images: 

 a. Place the first and last image where you want them on the slide. 

 b. Click and drag around the images to select them all. 

 

 
 

 c. From the Arrange menu, click Align.  Select Top , Middle , or Bottom  . 

 d. From the Arrange menu, click Distribute.  Select Horizontally.  

 

 
 

7. (Optional) Recolor an image:  

 

 a. Select the image(s) to be a different color. 

 b. Click Format options.   

 
c. Click the Recolor arrow.  Pick a color. 

 

 
Recolor images to show a fraction, ratio, or percent. 

For example: 60% 

 

8. (Optional) Crop an image:  

 

 a. Select the image to be cropped. 

 b. Click Crop image.  

 c. Drag a handle to remove part of the shape.  

 d. Click Crop image again.  
 

 
Crop an image to show a portion or part of a value. 

For example: 65 thousand people 

 

 
 

 
Copy and then crop an image to show part of a percentage.  

For example: 65% 

 

9. Sign out. 

The part outside 

the black crop lines 

will be deleted. 

TIP: How to make an image two colors: 

1. Copy and paste to make an extra image. 

2. Crop the pasted shape.  

3. Recolor the cropped shape. 

4. Drag the cropped shape over top of another image.  

Use the Zoom tool  to 

magnify an image. 

Click on the image with the 

tool to enlarge it. To go 

back to the slide, right click 

the image. Or click the 

Zoom arrow and pick Fit. 
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Session 5 Tackle the Challenge 

 

Session 5 
Tackle the Challenge 

In this session, students illustrate solutions to environmental issues by designing 

their own icons using Google Drawings. Each image will be a simple 

representation made by combining shapes, word art, and cropped images. 

The original artwork will be inserted into the infographic with an explanation. A 

link to an advocacy group will invite viewers to get involved. 

 

Assignment 16: Which Organization Can Help? 

Assignment 17: What Are Solutions? 

Assignment 18: Make a Difference 

 

Session 5 Review: Match an Icon to Its Meaning 

Session 5 Extension Activity: Make a Collapsible Source List 
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Assignment 15: What Are Solutions? 

In this assignment, you design an icon that illustrates a solution to the environmental issue using 

Google Drawings. You will apply your drawing skills to combine shapes, word art, and clip art. 

 

What Is an Icon? 

 

An icon is a simple drawing made from lines and shapes. It is used to express an idea more 

quickly than words. 

 

Symbols or images used in icons should be universal. Most people must understand their 

meaning in the same way. 

 

What Are Environmental Solutions? 

 

There are many types of solutions to environmental problems. They can be: 

 

     
stop an  

action 

change consumer 

habits 

educate  

the public 

pass or  

enforce laws 

use different 

technology 

 

     
vote for change clean up  

the area 

ask for  

help 

think of a  

new idea 

donate to  

the cause 

 

Brainstorm Ideas for the Icon Design 

 

Refer to your Research Outline to select a solution to illustrate. 

 

Brainstorm a list of objects related to the solution. Write each object’s name in a box. When 

done, pick the object(s) you think most people will understand and use them in your icon design. 

 

 
  

SOLUTION: 
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Create a Google Drawings and Change the Share Settings 

 

1.  Sign into your Google account. Click New.  
  

  Click More. Select Google Drawings.  
  

  Replace Untitled drawing with solution. 
  

  Apply your skills to share.  Give Anyone with the link the role of Viewer.  

 

Set the Icon Size 

 

2.  From the File menu select Page setup.  
  

  Pick Custom.  
  

  Type 2 x 2. Select Inches. Click Apply. 
 

 
 

Apply Your Skills to Design an Icon for a Solution 

 

3. Select a shape for the background: 

 

o Click Shape.   Pick a category. 

o Draw a shape that fills the canvas. 

o Use your skills to format the fill and border of the shape.      

 

4. To design the icon combine shapes ,  Word art , and/or an image.  

 

   
 

5. Complete the checklist. Will viewers understand your icon? ✓ 

   The icon design is simple.  

   The icon uses symbols that are easy to recognize.  

   The meaning of the icon is clear in only a few seconds.  

   The icon will match the infographic.  
 

Sign Out 

DESIGN TIPS 
 

• Swap it: Right click on a shape. Pick Change shape. 

• Outline it: Click Format options, Check Drop shadow. Pick white. Drag the 

Opacity and Blur Radius sliders to the left. 

• Combine it: Select objects. From the Arrange menu, click Group. 

• Crop it: Click the Mask image arrow.  Select a shape. Click Crop.  

• Shadow it: Click Format options and choose Drop shadow. 
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Session 6 Let's Get Involved 

 

Session 6 
Let's Get Involved! 

In this session, students raise awareness about an environmental issue. They 

publish their infographic using Google Sites. Afterwards, they share their 

infographic at an Earth Keeper’s Conference. 

 

Assignment 19: Publish the Infographic 

Assignment 20: Host an Environmental Conference 

 

Session 6 Review: Infographic Reflection 
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Session 6 Review: Infographic Reflection 

 
 

You are an environmental steward! In this course, you designed an infographic that summarized 

facts about an important topic. Answer questions about your infographic. 

 

 

1. What was the most interesting discovery you had while researching the topic? 

  

 

2. What part of the infographic are you most proud of making? Why? 

  

 

3. If you had more time, what would you like to add to your infographic? 

  

 

4. What was the most difficult part of this course? How did you overcome the challenge?  

  

 

5. Which do you prefer, writing a report or designing an infographic? Why? 

  

 

 



 

 

 

Appendices 

 

Appendices 
 

Refer to the appendices for additional resources: 

Appendix A: Assessment Tools 

Appendix B: Glossary 

Appendix C: Contact Information 
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Infographic Rubric 

 
Needs Improvement 

Level 1 

Good 

Level 2 

Great 

Level 3 

Excellent 

Level 4 

Cause 
 

 

The cause is incomplete 

or missing. 

The cause is described 

but lacks a connection 

to human activity. 

The cause of the 

problem is described 

and forms a 

connection to human 

activity. 

The cause of the 

problem is described 

concisely and forms a 

connection to human 

activity that is easily 

understood. 

Effect 
 

 

Effect section is 

incomplete or missing. 

Two effects are 

described. 

Two effects are 

described and show an 

understanding of the 

content. 

Two effects are 

described concisely 

and show an 

understanding of the 

content. 

Images are not suitable 

or missing. 

Images illustrate the 

effects. 

Images are icons that 

represent the data 

effectively. 

Images are icons that 

represent the data 

effectively and are 

well-formatted. 

Facts 

 

Slide deck is incomplete 

or missing. 

Slide deck includes two 

facts. 

Slide deck includes two 

interesting facts that 

are compelling. 

Slide deck includes two 

interesting facts that 

are compelling and 

eye-catching. 

Stakeholder 
 

 

Stakeholder graphic 

organizer is incomplete 

or missing. 

Involvement of 3 

stakeholders is partially 

explained using a 

graphic organizer. 

Involvement of 3 

stakeholders is 

explained using a 

graphic organizer. 

Involvement of 3 

stakeholders is briefly 

but thoroughly 

explained using a 

graphic organizer. 

 Parts of the graphic are 

not easy to understand. 

Graphic is easy to 

understand. 

Graphic is easy to 

understand and 

conveys a message 

quickly. 

Thematic 

Map 
 

 

Map is incomplete or 

missing. 

Map pinpoints places 

related to the issue, 

with a description, and 

photo. 

Map accurately 

pinpoints places related 

to the issue, with a brief 

description, and photo.  

Thematic map 

accurately pinpoints 

places related to the 

issue, with a brief well-

phrased description, 

and relevant photo.  

 Some marker icons 

related to the topic. 

Marker icons are 

customized to relate to 

the topic. 

Marker icons relate to 

the topic and express 

information visually. 

Solutions 
 

 

Solution section is 

incomplete or missing. 

Two solutions are 

identified with a link to 

an organization. 

Two solutions are 

explained with a link to 

a reputable 

organization. 

Two solutions are clearly 

and concisely 

explained with a link to 

a reputable 

organization. 

 Icons represent each 

solution. 

Icons are original and 

represent each solution. 

Icons are original, high-

quality, and represent 

the solution. 

Organization 
 

 

Sections are not 

logically sequenced. 

Sections are logically 

sequenced. 

Sections are logically 

sequenced, and design 

elements divide 

information. 

Sections are logically 

sequenced, and design 

elements divide 

information creatively. 

Headings are unclear or 

missing. 

Some headings identify 

information clearly. 

Headings identify 

information clearly. 

Catchy headings 

identify information and 

grab attention. 

Purpose  
 

 

Infographic does not 

raise awareness about 

an environmental issue. 

Infographic raises 

awareness about an 

environmental issue. 

Infographic is 

informative and raises 

awareness about an 

environmental issue. 

Infographic is 

informative, raises 

awareness about an 

environmental issue, 

and inspires action. 



 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 

 

 

 

 

 

 



Sample Infographic: https://sites.google.com/view/aboutacidrain/home 

https://sites.google.com/view/aboutacidrain/home
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